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Interactive Data Visualization

Introduction
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What?

How?

Three-part analysis framework for a vis instance:

is the task being performed
what data is shown in the views,

and NOw is the vis idiom constructed in terms of design choices.



- Analyzing vis usage as chained
sequences of instances, where
the output of one instance is the
C How? input to another.

How? ‘

How?

>
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Interactive Data Visualization

Why Analyze Tasks Abstractly?
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Why Analyze Tasks Abstractly?

B Consider tasks in abstract form, rather than the domain-specific way that
users typically think about them
¢ Transforming task descriptions from domain-specific language into abstract form

allows you to reason about similarities and differences between them

¢ Example:

— Contrast the prognosis of patients who were intubated in the ICU more than one

month after exposure to patients hospitalized within the first week

— See if the results for the tissue samples treated with LL-37 match up with the ones

without the peptide”.

— compare values between two groups
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ﬁy vocabulary

® Why people is using a VIS

¥ Actions @ Targets
(3 Analyze (®) AllData
(®) Search () Attributes
(® Query (®) Network Data

@ Spatial Data

® Consider only one Goal at time

¢ Complex activities as a chained sequences of tasks

— Data abstraction
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Interactive Data Visualization

Who: Designer or User?
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Who: Designer or User?

® Specific tool versus General tool

¢ Specific: tools are narrow.
— The designer has built many choices into the design of the tool itself in a way that
the user cannot override
— They are limited in the kinds of data and tasks that they can address, but their
strength is that users are not faced with an overwhelming array of design choices.
¢ General: tools are flexible
— The breadth of choices is both a strength and a limitation: users have a lot of power,
but they also may make ineffective choices if they do not have a deep understanding

of many vis design issues.
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Interactive Data Visualization

Actions

FACULDADE DE ]
c CIENCIAS E TECNOLOGIA Task Abstraction - 14
UNIVERSIDADE NOVA DE LISBOA



& Actions

(®) Analyze

= Consume

= Discover = Present

il
/

= Produce

= Annotate

e O

= Record

(®) Search

Target known

Location

known Lookup

Location
unknown

@ Query

= Identify

> Compare

High-level

©

= Derive

Mid-level

Target unknown

Browse

) Q e Explore

Low-level
= Summarize

The choices at each of
these three levels are
independent from each
other, and it's usually
useful to describe actions
at all three of them.



High-level: Analyze
_

& Actions
(® Analyze
- Consume existing information
= Discover = Present =2 Enjoy
- T O Most common case
4 . / Al

> Produce new information

= Annotate -2 Record = Derive

N (v EE- L

FACULDADE DE _
Fc t CIENCIAS E TECNOLOGIA Task Abstraction - 16

UNIVERSIDADE NOVA DE LISBOA



High-level: Analyze - Consume

& Actions
(®) Analyze
> Consume existing information
" = Discover = Present 2 Enjoy

b /|

all

/ A
-I’ b‘

p (O

finding completely new things;
- the outcome is to generate a new hypothesis.
- to verify or disconfirm an existing hypothesis

sophisticated interactive idioms, because the vis designer
doesn’t know in advance what the user will need to see
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High-level: Analyze - Consume

& Actions
(® Analyze
> Consume existing information
= Discover " Present ! =2 Enjoy

Calllh.
/
-1

succinct communication of information, for telling a story with data, or
guiding an audience through a series of cognitive operations.

the present goal is not intrinsically limited to a static visual encoding

idiom; it’s very possible to pursue this goal with dynamic vis idioms that
include interaction and animation
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h-level: Analyze - Consume

& Actions
(® Analyze
- Consume existing information .
= Discover = Present ]
il }V Al Who wil be the user?
/ Al

Baby Name > @ 8oth O Boys O Girls 100125 | 1 |
[100( 25 | 1 |

Names starting with LAT" per million babies

| Latanya
Rank in 1960s: 693
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1990s 2000s 2012 1880s  1890s  1900s  1910s 1920s  1930s  1940s 1950s  1960s

1880s 1890s 1900s 1910s 1920s 1930s 1940s 1950s 1960s 1970s 1980s

Figure 3.3. Name Voyager, a vis tool originally intended for parents focused deciding on what to name their expected
baby, ended up being used by many nonparents to analyze historical trends for their own enjoyment. Left: Names
starting with ‘O’ had a notable dip in popularity in the middle of the century. Right: Names starting with ‘LAT’ show
a trend of the 1970s. After [Wattenberg 05, Figures 2 and 3], using hittp/www.babynamewizard.com.
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High-level: Analyze - Produce
_

& Actions
(® Analyze
> Produce new information
i > Annotate 2 Record § > Derive
? [_B' | ===== Ve
| v, § ===== 7 >

Demo on Tableau (Annotations and Histories)
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Population and Birth Rate (2012)
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Global population and
birth rate are
imbalanced.
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Indicators of Global Growth and Development

A few countries spend
more than 14% GDP
on health care.
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Indicators of Global Growth and Development

c
2
=}
©

>

a
o
a
[
1}
]
=)
©
2
c
191
o
<
o
a
n
@
Q
w
=]

Global population and
birth rate are
imbalanced.

A few countries spend
more than 14% GDP
on health care.

Mobile phone usage
grows much faster
than internet usage.

Following negative
economic growth, we
see interest rates
decline.

Europe continues to
be the most popular
tourist destination.

High GDP correlates
with ease of business.

Region

The Americas

Country/Region
(All)

Usage Type
Internet Usage
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GDP per Capita

Indicators of Global Growth and Development
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High-level: Analyze - Produce

N

& Actions

(® Analyze

2 Produce new information

2 Annotate = Record § = Derive

O\ ‘
b

J4! 3 ‘..
> £

1

{

A dataset often needs to be transformed beyond its original state in order
to create a visual encoding that can solve the desired problem.

To do so, we can create derived attributes that extend the dataset
beyond the original set of attributes that it contains.

Derive new dataset types
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Hiﬁh-level: Analyze - Produce

& Actions
(® Analyze
2 Produce new information
2 Annotate = Record = Derive

7

exports

imports

: trade
. balance

trade balance = exports —imports

Original Data Derived Data
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& Actions

(®) Analyze

= Consume

= Discover = Present

il
/

= Produce

= Annotate

e O

= Record

(®) Search

Target known

Location

known Lookup

Location
unknown

@ Query

= Identify

> Compare

High-level

©

= Derive

Mid-level

Target unknown

Browse

) Q e Explore

Low-level
= Summarize

The choices at each of
these three levels are
independent from each
other, and it's usually
useful to describe actions
at all three of them.



Mid-level: Search
e

& Actions
(®) Search
Target known Target unknown

Location . .

*e Lookup °°, Browse
known o .
Location @ Locat . @, ol
unknown A\ ‘o ocate A s. Xplore

All of the high-level analyze cases require the user to search for elements
of interest within the vis as a mid-level goal
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Mid-level: Search

& Actions
@ Search
Target known Target unknown

Location . .

*e Lookup Browse
known o
Location @ Locat . @, ol
unknown A\ ‘o ocate ] so Xplore

¥ Lookup (target and location known)

¥ Locate (target known and location unknown)

¢ To find a known target at an unknown location, the search type is locate: that is, find out where

the specific object is.
B Browse (target unknown and location known)

¢ users are searching for one or more items that fit some kind of specification, such as matching up

with a particular range of attribute values.
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Mid-level: Search

& Actions
@ Search
Target known Target unknown

Location . .

*e Lookup Browse
known o
Location @ Locat . @, ol
unknown A\ ‘o ocate ] so Xplore

® Explore (target and location unknown)
¢ Searching for characteristics without regard to their location, often beginning from an
overview of everything.

¢ Examples include searching for outliers in a scatterplot, for anoma- lous spikes or

periodic patterns in a line graph of time-series data
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& Actions

(®) Analyze

= Consume

= Discover = Present

il
/

= Produce

= Annotate

e O

= Record

(®) Search

Target known

Location

known Lookup

Location
unknown

@ Query

= Identify

> Compare

High-level

©

= Derive

Mid-level

Target unknown

Browse

) Q e Explore

Low-level
= Summarize

The choices at each of
these three levels are
independent from each
other, and it's usually
useful to describe actions
at all three of them.



Low-level: Query

& Actions

(®) Query
= Identify > Compare => Summarize

N \ S

\

IS

Once a target or set of targets for a search has been found, a low- level

user goal is to query these targets at one of three scopes: identify,

compare, or summarize.

Increase in the amount of search targets under consideration: one, some, or all.

identify refers to a single target,
compare refers to multiple targets,

summarize refers to the full set of possible targets.
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Low-level: Query

_

& Actions

S 253 sioen Rt trump 213

(® Query
= Identify > Compare = Summarize
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Different uses of a choropleth map of US election results, where each state
is color-coded by the party that won.

- a user can identify the election results for one state,

- compare the election results of one state to another,

- summarize the election results across all states to determine how many

favored one candidate or the other.
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& Actions

(®) Analyze

= Consume

= Discover = Present
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= Annotate
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(®) Search
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Location
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@ Query
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©

= Derive
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= Summarize

The choices at each of
these three levels are
independent from each
other, and it's usually
useful to describe actions
at all three of them.
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Interactive Data Visualization

Targets
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@ All Data

- Trends

L/

(® Attributes

= One

= Distribution

2> Extremes

(®) Network Data
- Topology

- Paths

Ve

(®) Spatial Data
- Shape

@ Targets

- Qutliers

= Many

- Dependency

High-level

- Features

wV

- Correlation = Similarity

specific types of
datasets




Targets: All Data

@ Targets

@ All Data

= Trends = OQOutliers - Features
‘ ‘ .00 LS |V

A trend is a high-level characterization of a pattern in the data.

EX: increases, decreases, peaks, troughs, and plateaus

Some data doesn't fit well with that backdrop; those elements are the

outliers

The exact definition of features is task dependent, meaning any particular

structures of interest.
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Targets: All Data
[ —
@ Targets

(® Attributes

2 One 2 Many
= Distribution > Dependency = Correlation = Similarity
o—eo P ’ - S
.. - ~
> Extremes
il

Attributes are specific properties that are visually encoded
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@ All Data

- Trends

L/

(® Attributes

= One

= Distribution

2> Extremes

(®) Network Data
> Topology

i

- Paths

Ve

(®) Spatial Data
- Shape

@ Targets

- OQutliers

= Many

- Dependency

- Features

wV

- Correlation = Similarity

specific types of
datasets

The abstract tasks of understanding
, : , and
are extremely common
reasons to use vis.

Each of them can be expressed in very
diverse terms using domain- specific
language.



Interactive Data Visualization

How to: a preview
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Encode

® Arrange

= Express = Separate

= Align

from categorical and ordered
attributes

= Color

= Hue = Saturation = Luminance
] ] O | |

2 Size, Angle, Curvature, ...

'l. l/— 1)) )




Manipulate

® Change

® Select

® Navigate
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Facet

(® Juxtapose

(® Partition
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mparing Two ldioms

Bacillus coagulans

@Kangaroo —
." E'Nomrdia calcarea
‘," @Kaola ———=iChloroflexus aurai
Methanobacterium
| Amehibians | | yarsupial @O pussum
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Boophilus microph
Vertebrates
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Bats - Nereis limbata

Stichopus japonicu
mphiuma tridacty
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| Reptiles

Discoglossus pictu
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Marine

Aquifex pyrophilu:

lostridium butyri

Figure 3.8. Comparing two idioms. (a) SpaceTree [Plaisant et al. 02]. (b) TreeJuxtaposer. From http/www.cs.umd.
edu/hcil/spacetree and [Munzner et al. 03, Figure 1].
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Comparing Two ldioms

® What: Input data: a large tree composed of nodes and links.

B Why: these tools are being used is for the same goal

¢ to a path traced between two nodes of interest to a colleague.
¢ In more detail, to paths between nodes and them.

What?

® Tree (® Actions

m 2> Present = Locate = Identify
\(_/ alln Qo :
Al e o o,
(® Targets
2 Path between two nodes

e

7
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Comparing Two ldioms
-

@Kangaroo

' | @Kaola

| Amphibians

@O pussum

Invertebrates

/| Birds l&,}ﬂ

Vertebrates 4

Fishes

| Reptiles

Marsupial
| @Platypus

| @wWombat

Bats
| | Camnivores

|/ | Herbivores

| Placental |

insectivores

\\ | Marine

\ | Primates

Shrews

Space Tree

allow the user to
navigate and to
select a path

SpaceTree ties the act of
selection to a change of what is
shown by automatically
aggregating and filtering the
unselected items.

rC
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https://www.cs.umd.edu/hcil/spacetree/

Comparing Two ldioms

Bacillus coagulans

r;‘%@Nocardia calcarea

——=iChloroflexus aurai

: % éMetha nobacterium
) , Auxarthron zuffiai

Boophilus microph

: Gehringia olympici
{ E.: Theatops erythroc

Cosmolaelaps trifi

Nereis limbata
Stichopus japonicu

Amphiuma tridacty

Discoglossus pictu

Mus musculus
Rattus norvegicus
ryctolagus cunict
‘_: - ‘Heterodon platyrh
Albula vulpes

Prostoma eilhardi
Pleurastrum pauci

quifex pyrophilu:

lostridium butyri

TreeJuxtaposer

allow the user to
navigate and to
select a path

allows the user to arrange areas
of the tree to ensure visibility
for areas of interest.

g il
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https://www.cs.ubc.ca/~tmm/papers/tj/

Comparing Two ldioms
| .

® What: Input data: a large tree composed of nodes and links.

B Why: these tools are being used is for the same goal

¢ to a path traced between two nodes of interest to a colleague.

¢ In more detail, to paths between nodes and them.
What? How?
® Tree ® Actions ® SpaceTree

AP\ > Present = Locate = ldentify 2 Encode = Navigate = Select = Filter = Aggregate
A <m0 EEe oo [0 @em B
(® Targets (® TreeJuxtaposer
2 Path between two nodes = Encode = Navigate = Select = Arrange

o/ EEE%"’ <ty ‘ .....
\ 5
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Deriving a new attribute

— T—l—.—:‘
7 \ :
= L
; § 4

(a) (b)

Figure 3.10. The derived quantitative attribute of Strahler numbers is used to filter
the tree in order to create a recognizable summary. (a) The important skeleton of
a large tree is visible when only 5000 of the highest-ranked nodes are drawn. (b)
The full tree has over a half million nodes. From [Auber 02, Figures 10 and 13].
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Deriving a new attribute: a chained sequence

_

Task 1 Task 2

58 74 58 %..74
.)é' 64 64
54 84 54 84
74 84 74 84
84 84
24 24 o

.64

94 94
In Out In In Out
Tree = Quantitative =) Tree == Quantitative =) Filtered tree
attribute on nodes attribute on nodes Removed
unimportant parts
What? y? What? | How?
3 InTree (® Derive ® InTree (® Summarize (@ Reduce
(® Out Quantitative (® In Quantitative attribute on nodes (® Topology () Filter
attribute on nodes (3 Out Filtered tree
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Interactive Data Visualization

Further Reading and Summary

Q&A
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Further Reading

B Chapter 3 of Visualization Analysis & Design, Tamara Munzner, 2015
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